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Intfroduction

This section describes the overall procedure for downloading and preparing, deploying, and starting
DCA.

The installation of DCA involves:

1. Installing the VMware vSphere client. For more information, see the VMware vSphere

documentation.
Downloading the installation package from the HPE Software Support site.
Reassembling the appliance OVA file using the installer

Deploying the template

a M w0 b

Starting the appliance
This completes the first time setup so that the appliance is ready to use.

Follow the post-installation tasks after the installation is complete.

Prerequisites

Before you start installing DCA on your facility, HPE recommends that you:

« Follow the industry-standard high availability and disaster recovery methods and practices,
especially when working with mission-critical IT systems. See DCA high-availability (HA) and

disaster recovery (DR).

« Verify that the date and time are set properly on your VM host system. Be sure to maintain an
accurate time on the host system, such as with NTP. This is because the VM guest will

synchronize with that time.

« Take avirtual machine snapshot before starting DCA for the first time.

Install DCA

This is the systematic procedure for downloading and preparing the OVA file for DCA.

1. Download all files that make up the DCA. This set includes the split OVA files, a configuration file,
documentation, and the DCA installer.
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10.
11.
12.

Create a folder that will hold the reassembled OVA file.
Run the executable to reassemble the OVA file.

Select English, Japanese, or Simplified Chinese language for the installer user interface and click
OK.

Click Next when the installer opens.
Select the target folder that you created in Step 2 and click OK.

Click Install to finish installing the OVA file. The installer verifies that all the prerequisites for
application reassembly of the split OVA file are installed.

The Perform Integrity Check box is selected by default.

Click Reassemble.The setup reassembiles all files for the appliance and shows a Reassembly
completed message once finished.
The OVA file is now complete.

Click Next.
Note down the location of the virtual machine files in the target folder.
Click Finish.

Navigate to the target folder that now contains the OVA file. Use this to deploy the OVA template.

Prerequisites for deploying the OVF template

Before you deploy the DCA appliance, ensure that you have the following information:

REQUIRED

Hostname A fully qualified hostname for the appliance.

Note: This hostname is used by the portals for redirects, therefore it should be
resolvable on the hosts that are used to connect to the appliance portals.

Deployment = A static IPv4 address for the deployment network that will be assigned to the
IP address appliance. A DHCP-assigned address for the appliance is not supported.

Subnet Network mask

Mask

Gateway Network gateway

DNS One or more DNS servers. Multiple entries can be separated using a comma.
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root
password

Admin
account
password

OPTIONAL

Management
IP address

Subnet
Mask

vCenter IP

vCenter user

SMTP host

Password for the appliance root account.

Password for all the admin accounts for the embedded products SA, OO, ITOC, and
IT Operator Ul.

A static IPv4 address for the optional management network that will be assigned to
the appliance. A DHCP-assigned address for the appliance is not supported.

Network mask

One or more IPv4 address of a Windows vCenter to be managed by the appliance.

The ‘vCenter' is used to register one or more vCenter servers to enable the use of the
SA V12N feature to deploy and manage virtual machines using the OOTB DCA
virtual server provisioning offering.

Note The vCenters can also be added later through the Server Automation
interface. It enables the creation of VMs using this vCenter directly from the
appliance interface in your VMware ESXi environment.

Username and password for the vCenter admin user.

SMTP host for job email notification.

SMTP server is the IP or hostname of a specific SMTP server to be used in case
default ‘smtp’ does not work through SA. For more information, see "Configuring the
Mail Server for a Facility" section in the Server Automation Administration Guide.

Deploy the OVF template

When the template file is successfully created, it can be deployed using VMware vCenter 5.x or 6.x. If
you want to deploy the appliance in multiple networks, see Deploying in a multiple network

environment.

1. Start the VMware vSphere client.

2. Onthe menu bar, select File, then Deploy OVF Template.

3. Click Next. The vSphere Client Deploy OVF Template installer takes you sequentially through

eight installation steps, visible on the left sidebar of the installer.
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10.
1.
12.
13.

14.
15.
16.
17.

18.
19.

20.

21.

© ® N o o

On the OVF Template Details, review the details of the template such as Product, Version,
Vendor, Publisher, Download Size, Size on Disk available (depending on how the application is
provisioned), and the template description.

Read the End User License Agreement and click Accept.

Click Next.

On the Name and Location screen, specify the name and location for the deployed template.
Select an inventory location.

Select the default text in the Name window and rename the appliance.

Click Next.

On the Host/Cluster screen, select a cluster in which you want to run the deployed template.
Click Next.

On the Resource Pool screen, select a Resource Pool within which you want to deploy the
template.

Click Next.
On the Storage screen, select a storage location where you want to store the virtual machine files.
Click Next.

On the Disk Format screen, select your provisioning type. HPE recommends that you choose
thin provisioning as this requires less system resources.

Click Next.

On the Network Mapping screen, select the network for the deployed template, and then click
Next. You must always enable the deployment network. Optionally, you can select to attach the
application to a management network.

Note: Secure and insecure networks

Deployment networks are typically considered insecure as they may have DHCP and PXE
enabled. Provisioning and management of target servers happens in this network. Generally,
these do not have Intranet/Internet access. Management networks are typically considered

secure. Generally, these have access to the Intranet/Internet.

Complete the Properties screen. For information on the available options, see the table in the
Prerequisites for deploying the OVF template topic.

On the Ready to Complete tab, review your configuration, then click Finish to start the
deployment.
A status window shows the deployment progress. This process can take several minutes to an
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hour.

Note: Ensure that the Power on after deploymentcheckbox is not selected. You should

take a snapshot BEFORE you power on the virtual machine.

22. Click Close.

23. Locate the deployed appliance and run DCA. vSphere shows the appliance under Home >

Inventory > VMs and Templates.

Deployment in multiple-network environments

You can deploy DCA in an environment with multiple networks that handle different types of traffic and

can be isolated from one another.

The multiple-network environments defined in DCA are Deployment network and Management
network. These are explained in detail below:

Deployment network

This is the network used to provision and manage servers. It is considered the ‘insecure’ network with

PXE, DHCP, media servers, build servers. Typically, a deployment network does not have access to

Intranet/Internet.

Multiple networks
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Management network
This is the network used for configuration and administration tasks.

The appliance has two network interfaces that can be connected to the corresponding network. The
required configuration parameters will have to be provided during the OVF deployment for each of the
two networks.

If there is no use case-based separation in the environment and only one network is used, then only the
options for the deployment network need to be provided during OVF deployment and the management
network will be ignored.

By default, the embedded products are configured to listen on both interfaces, therefore the portals and
the SA Client will be available in both networks. If the two networks are isolated (traffic from one
network is not routed to the other), consider that:

« The Operations Portal performs redirects that use the hostname provided during OVF deploy.
Therefore, the hostname should be resolvable to a valid IP on the host from which the connection is
made.

This means that for a browser connecting from the management network, the hostname needs to
resolve to the appliance management IP and for one connecting from the deployment network, to
the IP of the deployment interface.

« There is only one default gateway defined for the appliance (usually set in the management
network). If the appliance is connected to isolated intranets (management and deployment),
connections to and from hosts that are not on the same subnet as the appliance will only be
possible if the default gateway is set in that intranet.

For example, in the following diagram, connections from WS3 workstation will not be possible
because the default route uses the management interface.
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WS1
192.168.200.11
Deployment (mandatory)
192.168.200.*
DCAA
Management (optional)
192.168.100.*
WS2
192.168.100.12

Capture a virtual snapshot

After you have deployed the appliance, and before turning the appliance on for the first time, it is

Deployment
Intranet

Management
Intranet

W33
192,168.201.11

W54
192.168.100.12

important to capture a system snapshot. This allows you to go back to an earlier state in the appliance

if you encounter any issues.

1. Right-click the deployed DCA appliance to open the context menu.

Navigate to Snapshot and then click Take Virtual Snapshot.

In the Take Virtual Machine Snapshot window, enter a snapshot name and description.

2
3
4. Click OK to create a snapshot.
5

In the vSphere Recent Tasks window, click on Create VM Snapshot to check that the snapshot

has been created successfully.

For better performance, you can remove the snapshot once the initialization phase competed

successfully.
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Starting DCA

Before powering on DCA for the first time, check that the date and time are set correctly on the VM
host system. The VM synchronizes with the Network Time Protocol (NTP).

1. Right-click the deployed DCA appliance and select Open Console.

2. Inthe Console window, click the green Play button to start the appliance.
The appliance starts, configures the network, and starts the initialization phase. This process
takes between 15 and 40 minutes.

Once initialized, you can start using the appliance. Check the /var/log/dca/first_time_setup.out log
file to make sure that the initialization phase is completed successfully. The log should end with a
BUILD SUCCESSFUL message.

Note: The initial configuration also sets up the firewall and opens only the ports that are
required by the components.

3. You will see alogin screen appear at the console prompt.
The default login information:

o The Management Console is available at: https://<appliance>:8444/csa
(username: admin / password: <configured admin account password>)

o The DCA Operations Portal is available at: https://<appliance>:8079
(username: consumer / password: <configured admin account password>)

o The Operations Orchestration portal is available at: https://<appliance>:8443/00
(username: admin / password: <configured admin account password>)

o The Server Automation client can be downloaded from https://<appliance>
Click on the “Download HPE Launcher” link and install the SA client. (username: admin /
password: <configured admin account password>)

o The IT Operations Compliance portal is available at: https://<appliance>:9100
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Post-installation tasks

Initialization phase tasks

» Configure and publish the offerings

Server provisioning tasks

Once your servers are provisioned, the appliance is ready to be used.

» Configure DHCP on the Appliance
« Configure the Media server
« Update/create build plans for the desired Operating Systems

« Create anew build plan

Other post-installation tasks

« Set up and define Server Automation (SA) software and patch policies
« Configure IT Operations Compliance business services, policies, and maintenance windows

« Add one or more vCenter manually
« Redeploy DCA using the initial appliance snapshot

« Configure and publish the offerings

Configure and publish the offerings

To make the offerings available on the Operations Portal, they first need to be configured and
published. The Provision Servers offering must be configured with your vCenter details before you can
use it to create new virtual machines.

To publish an offering:

HPE Data Center Automation (2016.10) Page 14 of 48



Installation and Administration Guide
Introduction

1. Gotohttps://<appliance>:8444/csa to connect to the Management Console.
Click Offerings.

Click the desired offering and select the desired version.

> w0 b

Review the offering configuration, by accessing the Options tab. For the Provision Servers
offering to be able to create new virtual machines, configure the New Virtual Servers section with
appropriate values for the appliance-managed vCenter. For example: Datastore, inventory folder,
network name.

5. Save your changes.

6. Access the Publishing tab and click Publish to make the offering available on the Operations
Portal.

7. Select the category Server Management, then click Publish.

8. Check the Offerings section for more information on each available offering.

Configure DHCP on the appliance

The DHCP Network Configuration Tool for IPv4 is installed on the appliance. To configure networks for
provisioning:

1. Log in as root on the appliance.

Note: (Optional) Make a backup copy of the configuration file with the following commands:
o cd /etc/opt/opsware/dhcpd

o cp dhcpd.conf dhcpd.conf.orig

2. Runthe DHCP Network Configuration Tool with the following command:
/opt/opsware/dhcpd/sbin/dhcpdtool

The following DHCP Network Configuration Tool main menu appears:
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Full DHCP Management

P Manag

A1l

o Toadd anew network, enter ‘a’ at the Opsware DHCP Network Configuration Tool prompt:

yrk Configu ion Tool

o To configure the DHCP service on the local network, enter ‘c’ at the prompt. Local networks are
detected automatically and displayed.

o If you are adding a local network, enter the IP addresses or host names of the DHCP range and
the DNS servers. A comma and a space separate the IP addresses.

o If the displayed information is correct, enter 'k’ to keep the network and return to the main menu.
o At the main menu, enter ‘s’ to save the information you have entered.
o To edit a configured network, enter the corresponding integer and go to step 2.

o To exit the DHCP Network Configuration Tool, enter ‘e’. You are prompted to start (or restart)
the DHCP server process.

o To start (or restart) the DHCP server process, enter ‘'y’. The DHCP Network Configuration Tool
displays diagnostic output as part of its start-up.

Configure the media server

To perform OS provisioning tasks, a media server that hosts the installation media for the desired
Operating Systems is required.

For more information on setting up the media server, see the Server Automation Administration Guide.
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Create build plans for the OS

To perform server provisioning, DCA requires build plans for each desired operating system.

Build plan templates

Copy the templates available from the SA library to create build plans filtered correctly in the
Operations Portal. These supplied templates are available under /Opsware/Tools/build plans/SAVA
and their have the required custom attributes for filtering in the Operations Portal.

Custom build plans

Create your custom build plans in the corresponding SA library folder under
/Home/CommonCustomerBuildPlans. For example, in the ProLiant folder, place build plans
customized for provisioning ProLiant systems, Non-ProLiant/<OS family> folder for others.

Create a new build plan

To create a build plan:

1. Start the SA client and access the Library.

2. Select the By Folder tab and navigate to the corresponding subfolder in:

/Home/CommonCustomerBuildPlans
Right-click and select New > OS Build Plan.
Provide a name for the build plan. This name will appear in the Operations Portal.

Click on Build Plan Items and click Copy Plan.

o o &~ w

Select a build plan for the desired OS from one of the subfolders of /Opsware/Tools/build
plans/SAVA

~N

Configure the Set Media Source step in the build plan then click on the Set Media Source step.

8. Set the Parameters field to a working network share that contains the media for the Operating
System.

9. Click onthe Custom Attributes Viewand add custom fields so that the build plan can be filtered
correctly in the Operations Portal.
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10. Enteravalid key for your Windows version in the Product Key attribute row.

11. Click File > Save or type CTRL+S to save your changes.

Add custom attributes

Your build plan must configure custom attributes so they can be picked up by the offerings.

HPE ProLiant-specific build plans (any platform)

1. Add build plans under Home/CommonCustomerBuildPlans/ProLiant

2. Add the following custom attributes: ApplicableServerType - physicalproliant

Non-HPE ProLiant-specific build plans

1. Add build plans in the following locations according to their target platforms
o Linux - Home/CommonCustomerBuildPlans/Non-ProLiant/Linux

o Windows - Home/CommonCustomerBuildPlans/Non-ProLiant/Windows
o Solaris - Home/CommonCustomerBuildPlans/Non-ProLiant/Solaris

2. Add the following custom attributes:
o ESXionly - ApplicableServerType with avalue of physicalnonhp,virtual or
physicalnonhp,physicalproliant

o VMwareGuestOsName with a value of one of the following: centos64Guest,
oraclelLinux64Guest, rhel5_64Guest, rhel6_64Guest, rhel7_64Guest, slesll 64Guest,
sles12 64Guest, ubuntu64Guest, solarisl® 64Guest, solarisll 64Guest,
windows7Server64Guest, winLonghorn64Guest, windows7Server64Guest.

Add a vCenter manually

This is the process for bringing vCenters under DCA management, and is the only way to add vCenters
into migrated appliances.

1. Install the SA Agent on the Windows server where the vCenter runs.
Make sure you install the agent with full software and hardware registration. Check the
Immediately do full hardware registration and Immediately do software registration options
in the Advanced section.
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Go to Virtualization > VMware vCenter.
Right-click on the right pane and select Add Virtualization Service.

Select the server and provide the credentials needed to authenticate with the vCenter.

o M 0 b

Grant permissions on the vCenter for the SuperUsers group. This enables operators to use
vCenter in the portal.

The virtualization framework only supports managing vCenters running on Windows operating system.

Enable secure communication

To enable secure communication between the vCenter and the appliance, activate the secure mode
and import the vCenter certificate into the appliance.

Redeploy DCA using OVF properties

After DCA is set up and deployed, you can redeploy the appliance from a snapshot using a new
configuration.

If you took a snapshot of the DCA appliance before starting it for the first time, you can redeploy the
appliance from a first time startup again. You can also bring up the appliance multiple times with
different settings. This means that you can use the snapshot as a fresh starting point for the appliance
then change its mode and configurations.

To deploy a DCA appliance from a snapshot:
1. Import the appliance using Deploy OVF template.

Follow the wizard and configure the appliance.

Take a snapshot.

> w0 D

Run the appliance.

To redeploy the appliance from a snapshot:

1. Revert to the snapshot that was taken before the first appliance start.
Open the appliance settings and click on the appliance.

Click on Getting Started; click on Edit virtual machine settings.

> w0 b

Navigate to the Options tab, select vApp options/Properties on the left pane.
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Edit the properties.
Save the new settings.

Take a new snapshot before your first start.

®©® N o o

Run the appliance.

SA software policies

For more information on how to create software policies and manage packages, see the Server
Automation User Guide.

You can use the product documentation library to find the latest version of this guide on the HPE
Software Support site (HPE Passport required).

SA patch policies

To patch the managed servers, the patch metadata database and patches need to be imported, and the
patch policies should be defined.

For more information, see the Server Automation User Guide.

You can use the product documentation library to find the latest version of this guide on the HPE
Software Support site (HPE Passport required).

IT Operations Compliance business services,
policies, and maintenance windows

To enable ITOC integration from the IT Operations Portal offerings, business services, policies and
maintenance windows will need to be setup in ITOC so they can be selected from the Operations Portal
offerings.

For more information, consult the IT Operations Compliance User Guide.

You can use the product documentation library to find the latest version of this guide on the HPE
Software Support site (HPE Passport required).
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Offerings

This solution offers the following offerings for server management:

» Provision servers
o Remediate server policies
« Manage servers

« Install Server Automation Agents

Functionality supported in this solution

This offering remediates already attached patch and/or software policies on a device group or on an
individual server.

Policy remediation and deployment on the managed server involves the following steps:

« Remediate a patch and/or software policy on a server or server group

« Install software packages on a server

« Attach a patch policy to a managed server hence associating that policy with the server

« Attach a software policy to a managed server hence associating that policy with the server

« Execute server scripts on a managed server

Set up DCA default offerings

Server provisioning

This service offering provisions operating system baselines onto a physical server or multiple virtual
servers. The IT operator has the option to either provision one network-booted unprovisioned server at a
time or multiple virtual servers on VMware virtualized environments.

In addition to provisioning options, the IT operator can optionally select to link the new server into a new
or existing ITOC business server and optionally link the business service to ITOC policies and
maintenance windows.
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Options for provisioning a network-booted server

This part of provisioning the offering assumes that there is an un-provisioned server in Server
Automation (SA) and it can be either a physical server or a virtual server, which can then be provisioned
by an IT operator by choosing from available options.

HPE ProLiant servers offer an advantage in functionality over a third-party server. For example, HPE
ProLiant servers have the flexibility of network booting from any service OS in SA and are will still be
able to perform any OS provisioning due to SA’s enhanced iLO integration.

Third-party or virtualized servers have the limitation of supporting provisioning of only those operating
systems that are supported by the booted service OS. For example, if a third-party or virtual serveris
booted with a Linux Service OS, then only Linux-based OS build plans are shown on the Operations
Portal.

There are seven server options to be chosen by the Operations Portal:

« four of them are dynamic
« two are optional

« three are non-dynamic and optional

The table below details these options:

Dynamic server options

Option Description

OS Build A dynamic list of the SA's OS build plans that are applicable for the selected booted
Plan server are displayed.

For an HPE ProLiant server, the OS build plans are listed from two folders,
/Opsware/Tools/Build Plans/SAVA/ProLiant and
®/Home/CommonCustomerBuildPlans/ProLiant. The first folder has HPE-supplied
build plans and the second one is for customer updated build plans.

For a non-ProLiant or Virtual Server, depending on the service OS, build plans from
Linux or Solaris or Windows folder in ¢/Opsware/Tools/Build Plans/SAVA/Non-
ProLiant and ®/Home/CommonCustomerBuildPlans/Non-ProLiant folders are
shown. The first folder also has HPE supplied build plans and the second one is for
customer updated build plans.

Non-ProLiant subdirectories:
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This configuration of entries can be found in the file: $CSA_HOME/jboss -
as/modules/sun/jdk/main/service-loader-resources/sa-
provider.properties

hp.sa.osbp.nonproliant.internal.sub.dir.linux=Linux

hp.sa.osbp.nonproliant.internal.sub.dir.windows=Windows

hp.sa.osbp.nonproliant.internal.sub.dir.solaris=Solaris

hp.sa.osbp.nonproliant.customer.sub.dir.linux=1inux

hp.sa.osbp.nonproliant.customer.sub.dir.windows=windows

hp.sa.osbp.nonproliant.customer.sub.dir.solaris=solaris

A dynamic list of Un-Provisioned Servers network booted with one of SA's Service OS
are shown here. The IT operator has to choose which server to provision.

Optional. Can be up to nine characters in length and will appear prefixed to hostname.
A hostname is automatically generated if nothing is specified.

Optional. A dynamic list of customers defined in SA are listed. The IT operator can
choose one.

Optional. A dynamic list of public and static Device Groups defined in SA are listed.
The IT operator can choose one.

Optional. A dynamic list of ITOC business services, compliance policies, and
maintenance windows are listed. You can also select to create a new business service
from the drop-down list, then provide a name for the business service in the edit field
below the drop-down.

Optional. An IT operator can specify an email address to be notified about the status of
the provisioning job in SA.

Note: This requires that SMTP configuration is setup on the SA side.

Optional and when chosen, the IT operator can specify a ticket ID of ITIL process for
the provisioning job in SA.

Optional. You can provide the name of the SA provider under $CSA_HOME/jboss -
as/modules/sun/jdk/main/service-loader-resources/sa-
provider.properties
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Options for provisioning VMware virtual servers

This part of the Provisioning Servers offering will allow an IT operator to provision up to 16 servers with
the chosen options in one pass, provided at least one VMware vCenter be registered with SA’s
virtualization service.

Note: To provision new VMware virtual servers, the vCenter needs to be managed by the
appliance. If the vCenter was not specified when the appliance was deployed, you can follow the
steps described in the “'Add a vCenter manually" on page 18" section to add your vCenter under
appliance management.

This VMware virtual server provisioning part of the service offering has both dynamic and non-dynamic
options. The dynamic options for provisioning are listed in the table below:

Dynamic provisioning options

Option Description

Hypervisor | A dynamic list of VMware hypervisors is shown here, from which the IT operator has to
choose one where the virtual servers would be provisioned.

Attachtoa | Optional. A dynamic list of customers defined in SA are listed. The IT operator can
Customer | choose one.

Attachtoa | Optional. A dynamic list of public and static Device Groups defined in SA are listed.
Device The IT operator can choose one.
Group

OS Build A dynamic list of the SA's OS build plans from Linux, Solaris, and Windows folder

Plan resides in the Opsware/Tools/Build Plans/SAVA/Non- ProLiant and
/Home/CommonCustomerBuildPlans/Non-ProLiant folders. These folders are for
HPE-provided and customer updated build plans.

Numberof = The number of virtual servers to be provisioned with the selected options. This can be
Virtual from 1-16.

Servers
Note: This number can vary based on a parameter set by the Administrator in

vCenter.

Number of = The number of CPUs in the virtual servers to be provisioned with the selected options.
CPUs This can be from 1-32 CPUs.

| Note: This number may also have restriction in the hypervisor.

Memory in = The memory in MB on the virtual servers to be provisioned with the selected options.
MB This can be from 512-1000000.
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Option Description

Note: This number can vary based on a parameter set by the administratorin
vCenter.

Hostname @ Optional. Can be up to 9 characters in length and will prefixed to hostname. A
Prefix hostname is generated if nothing is specified.

Datastore = Datastore is where the Virtual Servers configuration is stored. This datastore should be
accessible by all the hypervisors listed by the hypervisor dynamic option.

Inventory | Inventory folder on vCenter where the virtual servers will be created. Folder name
Folder should be in /Datacenter/<full path to folder>format.

Example: /<DC1>/Folderl/Folderll where DC1 is the datacenter name in vCenter.

Attach If chosen, the IT operator can specify a comma separated list of keys and values.
Custom

Server Note: The number of values and keys have to be same.

Attributes

Storage The type of storage devices on the virtual servers to be created. This is preset to SCSI,
Device IDE, which can be changed by the administrator or an IT operator while subscribing.
Type This can be a single value or a comma separated list, but the number of options

selected should match the storage options available; see options listed below.

Storage The type of storage devices on the virtual servers to be created. This is preset to disk,
Device cdrom, which can be changed by the administrator or by an IT operator while

Usage subscribing. This can be a single value or a comma separated list.

Type

Device The capacity in GB of storage devices on the virtual servers to be created. This is

Capacity  preset to 20, 0, which can be changed by the administrator or by an IT operator while
subscribing. This can be a single value or a comma separated list.

Non-dynamic provisioning options

Apart from the dynamic options, some non-dynamic options can either be preset by the administrator or
selected by the IT operator.

The administrator can control how these non-dynamic options are used, and whether they are available
to the IT operator. The table below lists these options:

Option Description
Storage The Datastore where the disks of the virtual servers to be created will be stored. This
Device can be preset/changed by the administrator or by IT operator while subscribing. This

Datastore can be a single value or a comma separated list. This datastore should be accessible
by all the hypervisors listed by the hypervisor dynamic option.
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This option is needed only when CD-ROMs are created and is preset to ,/mnt,
specifying that the mount point for the CD-ROM created. This can be preset/changed
by the administrator or by the IT operator while subscribing. This can be a single value
or acomma separated list.

Boolean values to specify whether the storage devices are connected to the Virtual
Servers to be created. This is preset to True, True, to connect both disk and CD-
ROM at startup and can be changed either by the administrator or by an IT operator
while subscribing. This can be a single value or a comma separated list.

Boolean values to specify whether lazy allocation should be used for the storage
devices of the Virtual Server(s) to be created. This is preset to True, True and can be
changed either by Administrator or by IT operator while subscribing. This can be a
single value or a comma separated list.

Network Interface Cards names. This is preset to etho, to add a single NIC on the
virtual servers to be created and can be changed either by the administrator or by an
IT operator while subscribing. This can be a single value or a comma separated list,
but the number of options should match with the network options, listed below.

Network Interface Cards key names. This is preset to etho, to add a key for the single
NIC on the virtual servers to be created and can be changed either by the
administrator or by an IT operator while subscribing. This can be a single value or a
comma separated list.

The network name in vCenter to which the NICs on the virtual servers to be created,
will be attached to and can be changed either by administrator or by IT operator while
subscribing. This can be a single value or a comma separated list.

The type of NICs attached to the virtual servers to be created and can be changed
either by the Administrator or by an IT operator while subscribing. This can be a single
value or acomma separated list.

Boolean values to specify whether the NICs are connected to the Virtual Servers to
be created. This is preset to True, to connect the NIC at startup and can be changed
either by the administrator or by an IT operator while subscribing. This can be a single
value or acomma separated list.

The network to be used for provisioning virtual servers from SA. This will be one of the
keys specified in NIC Key Option.

Optional. A dynamic list of ITOC business services, compliance policies, and
maintenance windows. You can also select to create a new business service from the
drop-down list and then provide a name for the business service in the edit field below
the drop-down list.

Optional. When chosen, the IT operator can specify an email address to be notified
about the status of the provisioning job in SA.

Note: This needs SMTP configuration to be setup on SA side.
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Attach Optional. When chosen, the IT operator can specify a ticket ID of ITIL process for the

Ticket ID provisioning job in SA.

Locking non-dynamic provisioning options

Some of the above non-dynamic options are marked locked and/or invisible by default. This can be

used in scenarios where the Administrator wants to limit certain options for the IT operator.

To change the visibility of these options:

—_

Log into the Administrator Portal as an Administrator.

2. Under the Provision Servers offering, click the Options tab.

w

Select the corresponding option as shown below:

< Provision Servers

Overview  Publishing  Options D

Options

- B 1 Hypervisor

= B 2 Number of Virtual Servars

& 3 Number of CPUs

(B & Memory in MB Locked
r 5. Hosframa Prafix

- 6. Datastore Hidden

- 7 Inventory foldar
~ [&y Virtual Server Attributes

Attach Server fo a Customear

L B customer

Aftach Server fo 3 Device Group
L B Device Group

Attach Custom Server Attributes

Server provisioning options for ITOC

Bl
& Memory in MB
Display Nam.
£ Memory in MB
Description
J Valu,
2048 =

Enter a valug befwaan 512 and 1000000
Marketplace Portal Options

Hidden

| Locked

Unsaved Changes

Note: These options are supported only in the Premium version of the product.

The following options are available for configuring Server Provisioning offering with Operations Portal.

Newly provisioned servers can be attached to policies and business services defined in ITOC. The

options are available for both provisioning network-booted servers and virtual servers.
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Option Description
Attach The following set of options allow attaching the newly provisioned server to existing
Policies ITOC policies. After the server is provisioned, it will be added to the specified
Business Service and new Statement of Applicability (SOA) will be created using the
selected policies, maintenance windows and the business service.
Select A dynamic list of production policies defined in ITOC.
Policies
Select A dynamic list of maintenance windows defined in ITOC.
Maintenance
Windows
Select The name of a new Business Service that will be created. If - -NONE- - is specified, a
Business name will be automatically generated.
Service
Name
Attach The following set of options allow attaching the newly provisioned server to existing
Business Business services.
Services
Select A dynamic list of Business Services defined in ITOC.
Business
Service
Default The name of a Business Service. The DCA administrator may use this option to
Business specify a Business Service to which the newly provisioned servers are added by
Service default.

For more information about the Provision Servers offering in DCA, see Provision Servers.

Remediate attached patch and software policies

The Server Policy Remediation offering remediates already attached patch and/or software policies on
a device group or on an individual server.

Change the timeout for a device group

The time taken to remediate a Device Group can vary greatly depending on how many servers the
Device Group has and how much time each of the server remediation will need. Hence, the timeout
value for waiting for a Device Group remediation to complete is made configurable using a system
property called DCAA_Remediate_DG_Timeout on OO central.

By default, this property is set to 4 hours (in milliseconds). To change it:
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1. Gotohttps://<DCA-Appliance-IP>:8443/00 tologinto OO Central.
Click on Content Management.

In the Configuration Items tab, expand System Properties.

> w0 b

Choose DCAA_Remediate_DG_Timeout system property and update the Override value to a
desired timeout value in milliseconds.

For more information about the Server Policy Remediation Offering in DCA, see Server Policy
Remediation.

Manage Servers offering

This solution is part of the Data Center Automation Suite that demonstrates how to manage life span of
various servers using HPE SA. SA provides the ability to manage servers individually or in a device
group by implementing a well-defined process of remediating and deploying software policies and
software packages.

The Manage Servers offering provides support to remediate additional software policies and/or
software packages on an individual server. This offering also supports running server scripts on the
selected server, and can send email notifications detailing the results of jobs run on the server. In
addition to the manage server options, the IT operator can optionally select to link the serverinto a new
or existing ITOC business server and optionally link the business service to ITOC policies and
maintenance windows.

Options for Manage Servers offering

The Manage Servers offering has the following options:

Option Description

Server Name A dynamic list of servers managed by the SA instance embedded in
the appliance

Install Software Packages = A dynamic list of software packages imported in SA

Run Additional Patch A dynamic list of patch policies defined in SA
Policies

Run Additional Software A dynamic list of software policies defined in SA
Policies

Run Server Scripts A dynamic list of servers scripts defined in SA
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Manage servers with ITOC

Note: These options are supported only in the Premium version of the product.

Option Description

Select Business = A dynamic list of business services defined in the ITOC instance embedded in
Service the appliance

New Business The name of a new business service that will be created if the operator selects
Service name to create a new business service in the list above.

Select Policies A dynamic list of policies defined in ITOC. Only policies in production state are

loaded.
Select A dynamic list of maintenance windows defined in ITOC.
Maintenance
windows

Request the Manage servers offering

Before operators can use the Manage Servers offering, the administrator using the SA Client should
define the content required by it.

« Import software packages
« Define software policies
« Define patch policies

o Create scripts

For detailed steps, see Server Automation Administration Guide.

For more information about the Manage Servers offering in DCA, see Manage servers.

Server Automation (SA) Agent installation
| Note: DCA supports installing the SA agent one server at a time.

This service offering installs the management agent on a target server to be discovered and managed
by Server Automation for application provisioning and ongoing lifecycle management.
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Subscribe to the Install Server Automation (SA) Agent
offering

1.

9.

©® N o o » w0 DN

Log onto the Operations Portal at https://<ipaddress>:8079

Click All Services.

Select the Install Server Automation (SA) Agent offering.

Create a Server IP or hostname.

Enter the administrator username for the user with Admin rights on the server.
Enter the administrator password.

Select the Server OS family for the server from the list of options.

Select one of the facilities listed, where the server is hosted.

(——| T 8l St ot Mo s oo ORI A gt (L0 P Sa——
] MU N

=l S S S ————— R Tacan

sy e b e e e e b YA L Bt b A s o e

e —

= .
= - Demuid
|——

& Dada of Sevver i Hamage

2 At v L e

-------

Perform a checkout operation. Include the Subscription Name and Service Description,

Subscribing Period (the time period your subscription will operate). Optionally, you can attach
documents to the service that are relevant to the user subscribing to the service.

HPE Data Center Automation (2016.10) Page 31 0of48



Installation and Administration Guide
Offerings

10. Select Submit Request to subscribe to the service.

. Order Information Summary
l rovide & meaningful name dasthe

E
E ver Automation (SA)
ent (1.1.
=] A=t ™o
E Published on Oct 7, 2016 103130 AM
Description

~

Server

(1921681002

rio
2 Admi me Croof)
_l! Group Ownership is Off ’

4 O Family CUnix
5 Facility (Appliance)

Subscription Period

Start Date

End Date

10/10/16 Pick Date.

Atrach Documents
) S

ure the files you upload are free of viruses and other

icious files may have legal consequences

Integrate and configure DCA components

Integrate with Cloud Service Automation (CSA)

This integration allows administrators to use the SA component as the provider for a CSA installation.

Once configured, the CSA administrator has access to the provisioning, patching and policy
management capabilities delivered as part of the DCA bundle.

Specify the hostname of the DCA appliance when configuring the SA provider in the CSA 4.7 instance
o Display Name: SA

User ID: <SA user account>. Must be member of SuperUsers group.

« Password: <account password>

Service Access Point; https://<DCA Hostname>:443

For detailed information on integrating CSA with DCA, see the CSA documentation on the HPE
Software Support site.

HPE Data Center Automation (2016.10) Page 32 of 48



Installation and Administration Guide
Offerings

Integrate with NA

The Premium version of the appliance supports integration with Network Automation (NA).
NA is not embedded in the appliance and is only supported as an external product.

To allow communication with NA, open the following ports:

o Port 1099 JNDI
« Port 1098 RMI Method
« Port 4446 RMI Object

For more details and information on configuring the NA integration, see the Server Automation
Integration Guide.

Integrate with OO

This integration allows administrators to integrate the Server Automation (SA) component with flows
from an Operations Orchestration (OO) 10.60 installation.

Integrating SA and OO makes it possible to use many features available in SA within custom OO flows
to solve specific use cases. The integration would rely on accessing the SA instance using the DCA
hostname and account credentials.

Set up DCA to use an external OO instance

Prerequisites

« Make sure the pathis set to: /usr/local/hp/csa/openjre/bin/java.

« Ifthe OO Central hosts permits connections on port 8443, you can invoke all the cURL commands
below from the appliance.

« The examples use the following credentials: admin/admin. To connect to your OO Central, change
the Authorization:Basic YWRtaW46YWRtaW4= header to use the password that you set for the OO
admin user. To do that, replace YWRtaW46YWRtaW4= string with the base64 encoding of

admin:<your_admin_password>.

To use the HPE SA provider with an OO environment:
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1. Inthe command prompt of the appliance, type the command: “which java” to discover the path set.
If it is not set, then we may need to add the above path to the system variable.

2. The following content packs (CP) need to be available in the external OO central (the listed
versions are the minimal requirements):
o 0010-base-cp-1.8.0.jar

o 0010-hpe-solutions-cp-1.8.2.jar

o 0010-cloud-cp-1.8.2.jar

o 0010-sa-cp-1.3.0.002.jar

o 0010.50-csa-integrations-cp-4.70.0000. jar

o Data Center Automation Appliance-cp-1.2.1.jar

All the content packs are available in the DCA_VA 1610 _00TB. zip that is part of the appliance
installation package.

3. The appliance requires OO user ‘admin’ to exist on the OO central instance and to have the
Promoter, Administrator, and System_admin roles. For example, for a freshly installed OO
instance, you can invoke the following command:
curl -X POST -d '{"password":"admin","roles":[{"name":"PROMOTER"},

"name" : "ADMINISTRATOR"}, {"name" : "SYSTEM_

ADMIN"}],"username":"admin", "permissions":"ADMINISTRATOR"}' --header "Content-
Type: application/json" -k https://<ooCentral>:8443/00/rest/users

4. Configure the CSA_OQ internal user on the OO Central. To achieve this, perform one of the
following actions:
o Loginto OO central and configure the user from Content Management > Configuration
Items. In Configuration Items, expand System Properties and edit CSA_00_USER. Its default
value is ooInboundUser. Input the value admin in the field Override value and click Save.

o Invoke the following command:

curl -k -X PUT -d 'admin' --header "Content-Type:application/json" --header
"Authorization:Basic YWRtaW46YWRtaw4="
https://<ooCentral>:8443/00/rest/content-config/CSA 00 USER?type=SYSTEM_
PROPERTY.

5. Configure CSA_REST_CREDENTIALS. For CSA to make REST calls to OO , we need to
configure CSA REST credentials on the external OO Central. To achieve this, perform one of the
following actions:

o Loginto OO Central and configure the credential from Content Management > Configuration
Items. In configuration items, expand System Account and edit CSA_REST _
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CREDENTIALS. Input the credentials of the admin user that you use to connect to the
appliance Administration Console and then click Save.

o Invoke the following command:

curl -k -X PUT -d '

{"username":"admin", "password": "<applianceAdminUserPassword>"}"' --header
"Content-Type:application/json" --header "Authorization:Basic
YWRtaW46YWRtaW4=" https://<ooCentral>:8443/00/rest/content-config/CSA REST

CREDENTIALS ?type=SYSTEM_ACCOUNT

6. Update CSA REST_URI. OO Central needs to communicate with the appliance to receive the job
details and to submit the results. This is specified through the CSA_REST_URI parameter. Set it
by performing one of the following actions:

o Loginto OO Central and configure the credential from Content Management > Configuration
Items. In configuration items, expand System Properties and edit CSA_REST_URI. Type the
URI (https://<appliancelP>:8444/csa/rest)in the Override value field and then click
Save.

o Invoke the following command:

curl -k -X PUT -d 'https://<appliance>:8444/csa/rest’' --header "Content-
Type:application/json" --header "Authorization:Basic YWRtaW46YWRtaW4="
https://<ooCentralIP>:8443/00/rest/content-config/CSA_REST_URI?type=SYSTEM
PROPERTY

Note: The following 3 steps (7, 8, and 9) apply only to DCAPremium, for running operations on
the embedded ITOC.

7. Configure ITOC_REST_CREDENTIALS. For OO to make calls to ITOC, configure ITOC credentials
on the external OO Central. Perform one of the following actions:
o Loginto OO Central and navigate to Content Management > Configuration Items. In
configuration items, expand System Account and edit ITOC_REST_CREDENTIALS, input the
credentials of the ITOCcsauser user and then click Save.

o Invoke the following command:
curl -k -X PUT -d '{"username":"csauser","password":"<ITOC_csauser_pass>"}"' -
-header "Content-Type:application/json" --header "Authorization:Basic
YWRtaW46YWRtaW4=" https://<ooCentral>:8443/00/rest/content-config/ITOC_REST
CREDENTIALS?type=SYSTEM_ACCOUNT

8. Update ITOC_REST_URI. OO Central needs to communicate with the appliance to run actions
on ITOC. Configure this by performing one of the following actions:
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o Loginto OO Central and configure the credential from Content Management > Configuration
Items. In configuration items, expand System Properties and edit ITOC_REST_URI. Input
the URI (https://<appliance>:7771) in the Override Value field and then click Save.

o Invoke the following command:
curl -k -X PUT -d 'https://<appliance>:7771' --header "Content-
Type:application/json" --header "Authorization:Basic YWRtaW46YWRtaw4="
https://<ooCentral>:8443/00/rest/content-config/ITOC_REST_URI?type=SYSTEM_
PROPERTY

9. Update SA_ITOC_PLATFORMMAP_CSV_PATH. The platform mapping file needs to be
available on the OO Central host to run actions on ITOC:
o Copy the file from the appliance (/usr/local/hp/oo/sa-itoc-platformMap.csv)to your OO
Central host.

o Update the SA_ITOC_PLATFORMMAP_CSV_PATH configuration item. Log into OO Central
and navigate to Content Management —> Configuration Items. In configuration items,
expand System Properties and edit SA_ITOC_PLATFORMMAP_CSV_PATH. Type the path on the
OO Central host where you copied the file in the Override Value field and click Save.
Alternatively, you can run the following command:

curl -k -X PUT -d '<path>"' --header "Content-Type:application/json" --header
"Authorization:Basic YWRtaW46YWRtaW4=" https://
<ooCentral>:8443/00/rest/content-config/SA_ITOC_PLATFORMMAP_CSV_
PATH?type=SYSTEM_PROPERTY

10. Export the OO certificate on the OO Central host.
o For Linux, run keytool -export -alias tomcat -file <path>/oo-certificate.crt -
keystore /usr/local/hp/oo/central/var/security/key.store

o For Windows, run <OQO_Intall_Dir>\java\bin\keytool.exe -exportcert -alias tomcat
- file C:\oocentral.crt - keystore <00_ Install_
Dir>\central\var\security\key.store

o Copy the certificate to the appliance.

o Import the OO certificate into the CSA certificate store on the appliance:
keytool - importcert -alias externalOO - file <path>/oo- certificate.crt -

keystore $CSA HOME/openjre/lib/security/cacerts -storepass changeit -noprompt
11. Update the OO engine used by the appliance.

o Inthe updateOOEngine.py file update the access point URI
(https://127.0.0.1:8443/PAS/services/WSCentralService) line to match your OO host details.
For example you can run the following command:
sed -1 's/127.0.0.1:8443/<00CentralHost>:<00CentralPort>/"' updateOOEngine.py
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12.

13.

o Run the updateOOEnNgine script to perform the update:
/opt/opsware/bin/python2 /var/opt/sava_firstboot/updateOOEngine.py --CSAUSER
admin --CSAPASS <password> --OOUSER admin --OOPASS <password>

Restart the CSA service on the appliance using the following command:
service csa restart

Update the HPSA provider:
a. Connect to the Administration console: http://<appliance>:8444/csa.

b. Access Providers > HPSA and click Edit.

c. Update the Service Access Point field to use the appliance hostname or IP instead of
localhost.

Integrate with OBR

This section describes the process of integrating OBR with DCA Suite Premium. This integration will

help you use the reporting capabilities in OBR for the embedded Server Automation component of DCA

Suite Premium.

Note: The OBR SA Reports Content Pack provides reporting capabilities to only Server
Automation within DCA Suite Premium.

The post-installation configuration of OBR must be done right after installing OBR 10.00. Ifitis
configured after installing any patch versions, such as OBR 10.01, 10.02 and so on, installation of
the OBR-SA Reports Content Pack may fail.

The integration involves the following steps:

1.

Install the OBR 10.02 patch

Download and install the patch from
https://softwaresupport.hpe.com/group/softwaresupport/search-result/-
[facetsearch/document/LID/OBR1002LIN_00001.

Configure the OBR SA Reports Content Pack

To configure the Content Pack, see the Configuring the HPE OBR SA reports content pack
section of the HPE OBR-SA Reports Content Pack Configuration Guide. This guide is located at
https://hpin.hpe.com/contentoffering/obr-sa-reporting-content (on this page, navigate to
Resources > File Repository > Documentation).

Configure the DCA data sources
To configure the DCA data source, first enable SA in the OBR Administration Console. To do this,
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see the Configuring HPE SA data sources section of the HPE OBR-SA Reports Content Pack
Configuration Guide. This guide is located at https://hpln.hpe.com/contentoffering/obr-sa-
reporting-content (on this page, navigate to Resources > File Repository > Documentation).
Pre-register a data miner for DCA as a data source.

Perform the following steps to pre-register a data miner for DCA from the OBR Web
Administration Console:

a. Loginto OBR Administration Console: https://<obr-core-ip>:21412/BSMRApp
b. Select Data Source Configuration > HPSA.

c. Click Create New.

d. Inthe Connection Parameters area, enter the required values.

e. Click OK.

f. Click Save.
The Saved successfully message is displayed.

4. Set up and install data miners
To set up and install data miners, see the Setting up and installing data miners on the SA
server section of the HPE OBR-SA Reports Content Pack Configuration Guide. This guide is
located at https://hpln.hpe.com/contentoffering/obr-sa-reporting-content (on this page, navigate to
Resources > File Repository > Documentation).

DCA updates and patches

Data Center Automation (DCA) releases regularly scheduled updates, documentation releases, and
maintenance releases.

You can find out more information about new documentation, add-ins, upcoming software releases via
the HPE Live Network.

Apply DCA patches

Patches or updates to DCA must only be applied at the DCA appliance level. Do not apply product
specific patches or updates directly to the sub-component products (Server Automation, Operations
Orchestration) and not at the DCA level as this is not supported and DCA might stop working.
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Install appliance updates

To find the latest patches, go to the HPE Software Support site, select Dashboards > Patches and
then search for your product and version.

Product fixes, OS updates/patches/fixes, or any other update will be packaged as a single GZIP TAR
file.

To install the appliance update:

1. Copy the update file to a temporary location, such as /tmp.

2. Run the following appliance update script, using the location and name of the update:
o cd /var/opt/sava_update

o sh updateAppliance.sh/tmp/<name of update file>

DCA licensing

This section describes the steps that have to be performed to import licenses into each of the products
embedded in the DCA Suite.

Trial license

DCA Suite ships with a 90-day trial license, during which time the full functionality is available. To
continue using the appliance after the trial expires, import a full license.

Based on the version of DCA Suite that you have acquired, several license files will be generated.

Import a DCA license

By default, the license filename for the DCA Suite will begin with DCA-VAPP.

1. Copy the license file on the appliance, for example in the /root folder.

2. Run the following command: /opt/opsware/license/license_import.sh <path _to_License_
file>.

When the license is imported, the OO-central and Twist services restart.
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Example

/opt/opsware/license/license_import.sh ./DCA-VAPP-PREM"1.10 5240275.dat
License file path: ./DCA-VAPP-PREM"1.10 5240275.dat

Successfully installed license.

The status of the license is reported in SA.

T
HPE Server Automation - copper3.copper.qa.opsware.com !EI E
File Edit View Tools Window Help Logged in as: admin ‘ Bf

Search X %ﬁ Device Groups
‘Ser\rers v| View: |D Summary " ,’9 |Name '| | ‘
[#] Narne P Address 08 ®
‘Baued Searches '| % atmin -
B Puslic
Advanced Search
Devices
Dievice Groups
- Public
& ) serers

B A Managed Geners
------ Q Qracle Solaris Zones
------ () saAgentInstallztion
------ {{| unprovisioned Servers

Import an Operations Portal license

The license filename for Operations Portal starts with DCA-ITOP.

1. Open the file with a text editor and copy its content.
Gotohttp://<appliance>:8444/csa to connect to the Administration console as admin.
In the top-right corner, click admin.

Access Licensing and click Add.

o > 0 b

Inthe Add License Key dialog box, paste the content of the license file in the textbox and click
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Add.

Notice: You have 78 days remaining on vour trial Ii

Manage Software Li Add License Key
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®
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Compliance

Import an IT Operations Compliance license

| Note: ITOC licenses are generated only for the Premium edition.
The license filename for IT Operations Compliance (ITOC) starts with DCA-ITOC.

1. Copy the license file on the appliance in the following location: /opt/hp/itoc/license/
2. Rename the file so that it begins with ITOC. The filename must be in the format ITOC* . xm1.

3. Restart the ITOC service in order to import the license.

Example

cp DCA-ITOCPREM™1.10_5240283.xml /opt/hp/itoc/license/ITOCPREM”1.10_5240283.xml
/etc/init.d/itoc restart

admin =
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Import an Network Automation license
Network Automation (NA) licenses are generated only for the Premium edition.

NA is not embedded into DCA. Activate the license for the host where NA is running. The license
filename for NA will begin with DCAS.

1. Copy the license file on host running NA in the following location: /opt/NA/license.dat

2. Restart the Truecontrol service.

Example

cp DCAS_5240277.dat /opt/NA/license.dat

/etc/init.d/truecontrol restart

Import an Operations Orchestration license

The license filename for Operations Orchestration starts with DCA-00.

1. Connect to the OO portal.
Gotohttp://<appliance>:8443/00 as admin.

In the top-right corner, click on the license banner.

> w0 D

Click Install license.
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5. Click Browse, select the license file and click OK.

Install License

Install License

Browse

Caned oK

DCA accounts and passwords

On a newly deployed appliance, the passwords for the built-in user accounts are set to the value
specified in the OVF properties.

These users are:

« Administration Console —admin user

« |IT Operations Compliance — all built-in users (itocadmin, compliancearchitect, etc)
« Operations Portal — consumer user

o Operations Orchestration —admin user

« Server Automation —admin user
To change the passwords for these accounts, use the following tool:

/opt/opsware/bin/python2 /var/opt/hp/dcaa/utils/changeDCAAadminPassword.pyc --help

The tool will set the new password and will make the necessary configurations to keep the appliance
working. The tool can be used to set a new password for all accounts at the same time, or one account
at atime.

For example, to change the password of Administration Console admin user:
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/opt/opsware/bin/python2 /var/opt/hp/dcaa/utils/changeDCAAadminPassword.pyc -p
"newpassword’' -c -a 'ooadminpassword'’

Note: The password of the OO admin user needs to be supplied, for making necessary
configurations on the appliance OO engine, to keep the appliance functional.

DCA high availability (HA) and disaster
recovery

You may not want to spend time in a High-Availability setup, but in any case, you should spend time in
creating and following rigorous disaster recovery procedures for their environment.

Disaster recovery

Disaster recovery procedures will protect the DCA environment in case of catastrophic failure.
Recovering from such a disaster will depend on the type of failure: network, hypervisor, underlying bare
metal, disk array, and so on.

Disaster recovery on appliance upgrade can be performed in the following ways:

« Taking a snapshot before running the upgrade and revert to this snapshot if the upgrade fails. Delete
this snapshot when it is established that the appliance is running satisfactorily, to prevent any
performance degradation from the use of snapshots. Using VMware vSphere HA to protect virtual
machines provides detailed information.

« Ensure that you perform regular backups of the DCA virtual machine.

« Read the VMware documentation about backup best practices.

High availability

High availability is maximizing the uptime in case of failure of the hypervisor and/or the underlying
server that can be recovered nearly instantaneously and in an automated way. This is a lot more
difficult to achieve and is typically only implemented for mission-critical applications.

It can be implemented inside the application (in the) VMs, outside or both. If DCA is to be used as part
of a mission-critical application, you may elect to invest in high-availability setups that cover the DCA
appliance.
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The DCA appliance is not enabled for an in-product high-availability setup (the ability to run DCA
appliances in a two- or three-node cluster whereby the appliance file system is clustered, the system is
being monitored by heartbeat software, and failover from one node to any other node is handled
automatically).

Hypervisor vendors like VMware or Microsoft have their own high availability implementation, which is
largely independent of the actual application that is provided by the virtual machines being protected.
Currently, DCA only supports VMware ESXi.

High availability with VMware vSphere HA

VMware vSphere HA protects virtual machines from the following types of failures:

« If the ESX host the VMs running on fails
« Ifthe guest OS inside the VM fails
« If an application inside the VM fails

The basic requirement is for the DCA appliance to run in a vSphere cluster with more than one ESXi
host in that cluster.

Case 1 ESXi host failure

Heartbeats are sent between the ESXi hosts in the cluster, and VMs can be restarted on other hosts
within the cluster if one (or more) hosts go down. Crash and restart of a virtual machine containing OO,
ITOC, and SA is not without risk. It is possible that one or more of these products fail to recover from a
crash. Any running jobs will be marked as failed and will have to be restarted.

Case 2 Guest OS failure in the virtual machine

Heartbeats are being sent between VMware Tools inside the DCA appliance and the vCenter server.

If the heartbeats are no longer received from the virtual machine (the guest OS and subsequently, the
VMware Tools stops responding) then the vCenter server restarts that virtual machine.

Case 3 Application failure in the virtual machine

Heartbeat support has to be implemented in the application to be monitored, for which VMware has an
application monitoring SDK. This feature is not supported in DCA as it has not been added into OO or
SA inside DCA. Heartbeats are sent between VMware Tools inside the DCA appliance and the
vCenter server (as before). Heartbeats are also being sent between an application inside the virtual
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machine and the vCenter server. If the heartbeats are no longer received from the virtual machine (the
application inside the VM is no longer working), then the vCenter server restarts that virtual machine.

High availability in SA
In SA, high availability is typically achieved by adding whole cores, slices, and satellites with the SA
gateways on the satellites configured with crossed fail-over routes.

However, DCA is a single core setup with satellite support, so the options are limited because a
satellite does not run (other than the Word repository and OS provisioning boot server components) any
core functionality. If the DCA appliance goes down or becomes unresponsive, service is interrupted.
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Get support

Contact your HPE Support Representative for any information on DCA or on your Support and
Maintenance contract.

Log collection for support
e Run /opt/opsware/oi_util/support_tools/sa_scenesnap.sh to collect is a good starting set
of logs for support.
« Thelogs are gathered in the following location: /var/opt/opsware/tmp/
« Thefile will be named: sa_scenesnap.<hostname>.<date>.<time>.zip

« Thelog collection for support for Operations Portal and OO.

Additional support for DCA Suite Premium

The DCA Suite Premium edition provides the following additional support:

« More Content: Additional supported content packs available for download
« Audit and Remediation: Additional audit and remediation capabilities

« Larger supported environment: A single installation of the Premium edition can support up to
3000 licensed servers on a network

« Provisioning and managed platform: Solaris x86 support including support for Solaris zones
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Send documentation feedback

If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on Installation and Administration Guide (Data Center Automation Suite 2016.10)
Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client, and
send your feedback to hpedca-docs@hpe.com.

We appreciate your feedback!
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